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Overview

- Tools to be used
- Frequency bands and TV channels
- Procedure diagram

- CA Display tool



Tools to be used

@J-} G"D 2 Q

Broadcasting Online

TerRaQ

(TerRaNotices >

C_CA Display > WISFAT



https://www.google.com/url?q=http://www.itu.int/pub/R-SP-LN.IT/en&sa=U&ei=HIu9Ud3AJuic0AW8hIGYDA&ved=0CA4QFjAD&client=internal-uds-cse&usg=AFQjCNHwTQMAnIRPgtyg-z5NtwJTbqJi7A
https://www.google.com/url?q=http://www.itu.int/pub/R-SP-LN.IT/en&sa=U&ei=HIu9Ud3AJuic0AW8hIGYDA&ved=0CA4QFjAD&client=internal-uds-cse&usg=AFQjCNHwTQMAnIRPgtyg-z5NtwJTbqJi7A

Frequency bands and TV channels

v Frequency bands: VHF (174 — 216 MHz) and UHF (470 — 698 MHz)

v TV channels (assigned frequencies) — Doc. INFO-1:
- 6 MHz raster: 7 (177 MHz) — 13 (213 MHz)
14 (473 MHz) - 51 (695 MHz), excl. ch.37 (611 MHz)
- 8 MHz raster: 5 (178 MHz) — 9 (210 MHz)
21 (474 MHz) — 48 (690 MHz), excl. ch.38 (610 MHz)
- special case (“flexible channel”):
- 6 MHz raster:
For VHF band - ch82 (881 MHz)
For UHF band - ch83 (887 MHz)
- 8 MHz raster:
For VHF band — ch68 (850 MHz)
For UHF band - ch69 (858 MHz)
“flexible channel” — means that during compatibility analysis calculations,
the software will scan all available channels in the frequency bands
mentioned above and show electromagnetic situation on each channel
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Creation/Modification of a T02 notice

* TerRaMotices 1.2 (BR IFIC 2852) - [G_VRG_Road Town_flex_nf.bet* - T02%]

= C)

iw File Tools View Language

Options

Window  Help

PRBE LT X e-m A e = &

Notice browser

HEE

Notice type

4 G_VRG_Road Tow...

Head section
 T02)4DD
' T024DD
' T0214DD
 T02)4DD
' T024DD
+ T0214DD
 T02)4DD
' T024DD
+ T0214DD
 T02)4DD
+ T024DD
+ T0214DD
 T02)4DD
+ T024DD
+ T0214DD
 T02)4DD
+ T024DD
+ T0214DD
 T02)4DD
' T02ADD
+ T0214DD
 T02/ADD
T02|ADD*

' T02ADD

Description

G -02/08/2016
AIA_ANGUILLAL
ATA_ANGUILLA 2
ALA_ANGUILLA 3
AIA_ANGUILLA4
BER_HAMILTON 1
BER_HAMILTON 2
BER_HAMILTON 3
BER_HAMILTON 4
CYM_Georges Town 1
TCA_Cockburn Town 2
TCA_Lorimers 1
TCA_Lorimers 2
CYM_Georges Town 2
CYM_Georges Town 3
CYM_Georges Town 4
TCA_Cockburn Town 1
MSR_RICHMOND HILL 1
MSR_RICHMOND HILL 2
MSR_RICHMOND HILL 3
MSR_RICHMOND HILL 4
YRG_Road Town1
VYRG_Road Town 2
VRG_Road Town 3
VRG_Road Town 4

Date of notification

2 58 5201

ID1/ Assignment's unique identifier

VRG_Road Town 3

T02

Fragment Notification intended for 12A/ Operating 2(! Date of bringing into
— = - agenq
@ Artide 11 @ Addition 1 8 7] 2015
) GEB9 (2) Modification
- 12B/ Address 108/ Regular hours of
© sTe1 code operation (UTC)
From 00:00 To 2400
Assignment characteristics | Antenna characteristics |
Station information
4A [ Antenna site name 4/ gngitude 9EA[ Altitude of site above sea level 3A1/ Call sign
Road Town 54° || 37 e @ 192 m
4B/ Geographic area Latitude 3A2/ Station identification
[VRG v ] 18° {3+ 25 @
Emission characteristics
1A/ Assigned 701/ TV system 8BH) Horizontal e, 7AB/ Bandwidth 1EQ/ Offset
frequency 5000 kHz 0 "
837 MHz w 0 dBw g
FA1f Frequency stability 9D/ Polarization 8BV/ Vertical e.r.p. 7A/ Class of emission
- daw XTFXF
Antenna characteristics
9 Antenna directivity 9EB/ Maximum Effective Antenna Height 9E [ Height of Antenna Above Ground Level

Coordination successfully completed with the following administrations

Available administrations

AFG s Add >
AFS |_|

AGL < Remove
ALE

ALG - << Clear

Selected administrations

13C/ Notified remarks




J) Validation and Submission of the notice file to eBCD

v Validate and save the notice file

v’ Go to eBCD web-portal - eTools: https://www.itu.int/ITU-
R/eBCD/MemberPages/eCalculations.aspx and select the
CA_compat calculation type

v' Browse and upload the notice file together with the notice files of
neighboring countries to eBCD web-portal

v'  Label your job and click on Submit


https://www.itu.int/ITU-R/eBCD/MemberPages/eCalculations.aspx

Getting Compatibility Analysis results

v" Click on Back to calculation history

v' Wait for results

v' Save and unzip .mdb file on your local disk

v" Launch CA Display and open the .mdb file to view the results




CA Display (example)

File -> Open compatibility results file G_VRG_Road Town_flex.mdb
View -> Channel distribution statistics

Check appropriate boxes and set a default margin

Select Administration and click Refresh

Select item of interest and click on the blue number

List of requirements will appear

Select the requirement of interest and click on it

AN NN YN N

File Edit View Preferences Help

g4l Channel Distribution Statistics
Administration |G - Refresh

Show assignable channels if the maximum acceptable margin (dB) is: @7

Show assignable channels if ignoring incompatibilities between requirements where both have a range of available frequencies lgnare seff incompatibilities

Do not consider interference to the wanted requirement
Channel Distribution Statistics

Submitted Mo available channel or freguency Mo assignable channel or Having an assignable channel or
block freguency block a frequency block

a ’

UHF Channel Distribution | WHF Channel Distribution
Nul Adm | Geo Area | Adm RefId Mot Type | SitefAllot Name SFN Id Chiblock Avail. Chiblock Assignable Chiblock | i &~
20 G TCA TCA LORIMERS 2 T02 Lorimers 20 20 20
I 21G VRG WRG_ROAD TOWN 3 TD2 Road Town 14-51 14-16,18-22,24-51 14,16,19,21—22,25,27—29,31—33,35—39,41,45,4?,49—51'
4 22 G VRG VRG_ROAD TOWN 2 TODZ Road Town 16 16 16
23 G VRG WRG_ROAD TOWN 4 TD2 Road Town 21 21 21 Ij
24 G VRG VRG_ROAD TOWN 1 TD2 Road Town 25 25 25 -
4 (1] | 3




Analysis of the results:
List of affected ATV assighments

Bl Fle Edit View Preferences Help -

Administration G

Admiristration Unigue Identifier
CVRG_ROAD TOWN 3 ;

Site/Allotment Name

Road Town

Show multi-channel regs.

Detals |M|m|m|

(3eographical area VRG
Netice Type T2

Not linked

Acceptable Channel/Frequency Block

14F1
|Dgﬂdhafm|ﬂgﬂdh‘f&d&d|ﬂndonghaf
No. |Adm |GeoAwea AdmRefld  |BRE Site Name Anzlog Ch. | Interf. Dig. Ch. | 8BH(dBW)  BBV(dBW] Distance (km) |NFS (dB(uVim) Margin (dB) | Relation

P USA VIR 093002444 CHARLOTTEAMALIE 17 17 428 105 95 107 Interference
2 UsA VIR 038002432 CHRISTIANSTED 23 23 394 19.1 358 2044 Interference
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Analysis of the results:
List of interfering ATV assignments

B File Edit  View Preferences Help -5

Admiristration G
Administration Unique |dentifier
VRG_ROAD TOWN 3

Site/Allotmert Name

Road Town

Show mutti-channel regs.

Detais | Colours | Frequencies | Symbols |

Geographical area VRG

Notice Type Tz

Not linked &=

Acceptable Channel/Frequency Block

14 R4

—
| Digital Interferers | Digtal Affecte(] Analogue TV Interferers ) Analogue TV Affected
No. |Adm |Ge:§%1mmm;' |BRId | Site Name Analog Ch. | Aff. Dig. Ch. | 8BH(dBW]  8BV(dBW) Distance (km) |CNFS (dB(u¥/ |Margin (dB) |Relation
» b USA  PTR 093002437 SANJUAN 15 15 459 1979 572 6.14 Interference

2 USA VIR 093002444 CHARLOTTEAMALIE 17 17 483 767 885 36.19 Interference
3 USA  PTR 030617959 SJUAN 18 18 583 1547 823 3053 Interference
4 USA VIR 093002444  CHARLOTTEAMALIE 17 18 LR 767 535 365 Interference
5 UsA  PTR 030617959  SJUAN 18 19 583 1547 473 133 Interference
6 USA PTR 030618009 PONCE 20 20 50 2633 491 17 Interference
7 USA VIR 038002431 CHRISTIANSTED 21 21 295 177 529 335 Interference
8 USA VIR 038002432 CHRISTIANSTED 23 23 394 1202 639 11.94 Interference
9 USA  PTR 088002408 SJUAN 24 2 573 167.6 749 2267 Interference
10 UsA PR 038002409  PONCE 26 26 56.4 2633 553 5.14 Interference
1 UsA PR 030618246  SJUAN 30 30 642 1917 712 18.94 Interference
12 USA PIR 093002438 FAJARDO 34 34 47 1603 66.7 1462 Interference
13 USA PIR 038002413 FAJARDO 40 40 532 1593 75 2275 Interference
14 USA PR 093002439 YAUCO 2 42 613 2438 647 1272 Interference
15 USA PIR 093002440 GUAYAMA 45 46 613 1676 755 2325 Interference
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Analysis of the results:
List of affected DTV assignments

g File Edit  View Preferences Help

Administration G
Administration Unigue |dentifier
VRG_ROAD TOWN 3

Site:/Allatment Name

Road Town

Show muttichannel regs.

Details | Colours | Frequencies | Symbols |

Geographical area VRG
Motice Type To?

Mot linked

PAcceptable Channel/Frequency Block

1451
Pvailable Channel/Frequency Block

14-16,18-22 24-51

Digital m—rﬁ Digital Afected BogueWharfws | Analogue TV Afected |

No| Adm | Gea TNGL AdmRefld | SitlAllotName (Chiblock | Avail. Chiblock | Assigned Chibl| ~ 8BH (dBWW) BBV (dBW) Wanted  Interf| Distance (km| CNFS(dB(uV|  Margin (dE) Relaion |
4 1G  VRG T02 VRG_ROADTO Road Town 16 16 30 16 16 Txinside
2G VRG T02 VRG_ROADTO Road Town 21 21 30 a2 Txinside
3USA VIR T02 USA_106021588 CHRISTIANSTED 23 23 23 47 3 23 121 75 2097 Interference
4G VRG T02 VRG_ROADTO Road Town 25 25 30 5 25 Txinside
5USA VIR T02 USA_106021593 CHARLOTTEAMALE 43 43 43 47 43 43 111 778 24.46 Interference
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Analysis of the results:

List of interfering DTV assighments
B e Gt View Prefeences Help

Administration G
Administration Unique Identffisr
WRG_ROAD TOWN 3

Site/Allotment Name:

Road Town

Show mutti-channel regs.

Details | Colours | Frequencies | Symbols |

(Geographical arsa VRG
Natice Type T02
Net linked
Acceptable Channel/Frequency Block
1451
Available Channel/Frequency Block
14-16,18-22.2451
’t
Digtal Inteferers @a Hfected | Anslogue TV Interferers | Anlogue TV Affected |
\"
"No] Adm | Geo | Not |AdmRefld | SitelAllot Name | Chiblock Avail. Chiblock | Assigned chibl | 8BH(dBW] 8BV (dBW) Wanted | Interf Distance (km) CNFS (dB(wV|  Margin (dBf Relaton |
4 1G  VRG T2 VRG_ROADTO Road Town 16 16 30 16 16 Txinside
2USA VIR T02 USA_106021587 CHRISTIANSTED 20 20 20 56.6 20 20 12022 836 31.3 Inferference
3G VRG T02 VRG_ROADTO RoadTown 21 21 30 21 2 Txinside
4USA VIR T02 USA_106021588 CHRISTIANSTED 23 23 23 47 n n 1186 703 18.13 Interference
5G VRG T02 VRG_ROADTO RoadTown 25 25 30 % 25 Txinside
6USA VIR T02 USA_106021593 CHARLOTTEAMALIE 43 43 43 47 43 43 76.6 707 18.44 Interference
TUSA VIR T02 USA_106021594 CHARLOTTEAMALEE 44 44 44 53 “ou 774 97.2 4494 Interference
8USA VIR T02 USA_106021596 CHARLOTTEAMALIE 48 48 48 53 43 48 774 971 4479 Interference
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Summary of the compatibility analysis
on a channel-by-channel basis in the UHF band
(Tx inside, Overlaps or the highest calculated margins)

EE

Bl File  Edit View Preferences Help

o

Adminigtration

Administration Unigue |dertifier
VRG_ROAD TOWN 3
Site/Mlotment Name:

Road Town

Show mutti-channel regs.

Detals | Colours | Frequencies | Symbols|

Geographical area VRG
Notice Type To?

Not finked

Acceptable Channel/Frequency Block

1451
Awvailable Channel/Frequency Block

14-16,18-22 24-51
Assigned Channel/Frequency Block

Coord Completed

Digal Intsferers | Digital Affected | Analogue TV Interferers | Analogue TV Afiected |

No/Adm |GeoArea |NotType |AdmRefld | Site Name Channel Avail. Ch AssignedCh |  BBH(dBW]| 8BV (dBW] Wanted chann | Interf channel | Distance (km] CNFS (dB(uV|  Margin (dB] Relation
» | 16 VRG  T02  VRG_ROADTO RoadTown 16 16 30 16 16 Txinside
| 2usa VR T02  USA 106021587 CHRISTIANSTED 20 2 20 56.6 20 2 1202 336 31.3 Interference
|| 36 VRG  T02  VRG_ROADTO RoadTown 21 21 30 21 21 Txinside
| 4usa VR TO2  USA 106021535 CHRISTIANSTED 23 2 23 47 23 2 1186 703 18.13 Interference
| | 56 VRG  T02  VRG_ROADTO RoadTown % 2 30 % 2 Txinside
| 6usa VR T02  USA 106021593 CHARLOTTEAMALIE 43 43 43 47 43 43 766 707 18.44 Interference
| 7usA VR T02  USA 106021594 CHARLOTTEAMALIE 44 4 4 53 4 4 774 97.2 44.94 Interference
| susa VR TO2  USA 106021596 CHARLOTTEAMALIE 48 43 48 53 48 43 774 971 44.79 Interference
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Summary of the compatibility analysis
on a channel-by-channel basis in the UHF band
(Tx inside, Overlaps or the highest calculated margins)

Channel Fr_assign DTV DTV ATV ATV
No (MHz) Interferer Affected Interferer affected
6.14

473

479

485 Tx inside Tx inside

491 36.19 7.07
497 30.53

-
~

509 313 1.71
515 Tx inside Tx inside 3.35
521

527 18.13 20.97 11.94 20.44
533 22.67
539 Tx inside Tx inside

545 5.14
551

557

563

569 18.94
575

581

587

593 14.62
599

605

~N
~N

[
-

w
~

617

623

629 22.75
635

641 12.72
647 18.44 24.46

653 44.94

659

665 23.25
671

677 44.79

683

689

695

'S
h=y

S
N

[0
e
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Outcome of the analysis of the
7 compatibility results on ch 19 (503 MHz)

Conclusions:

1) Calculated margins in both directions (for
incoming and outgoing interference) do not exceed
the established margin, therefore channel 19
(assigned frequency 503 MHz) can be assigned to
this site.

2) To fix this, it is necessary to modify the initial
notice containing flexible channel 83 (887 MHz) by
assigning channel 19 (503 MHz).
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) Overall results of the compatibility analysis

For this site, it can be noticed that channels:

14, 16*, 19, 21*-22, 25%*, 27-29, 31-33, 35-39
(except ch 37), 41, 45, 47, 49-51 can also be
assigned.

*Those channels are already assigned

Other channels for this site are considered as
non-compatible.
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Thank you for your attention!

Questions?

brbcd@itu.int
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